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Shauna Belyeu, publisher 
of The Eufaula Indian Journal 
and McIntosh County Demo-
crat, took office as president of 
the Oklahoma Press Associa-
tion on July 1.

She was elected by OPA 
members during the annual 
business meeting at the June 
7-8 OPA Convention in Okla-
homa City. Belyeu succeeds 
Sheila Gay as president and 
will serve a one-year term.

“I am so proud of our ex-
tremely proactive association 
and that I have the privilege to 
serve alongside such a great 
board and staff,” she said.

Belyeu graduated from 
Northeastern State University 
with a bachelor’s degree in 
criminal justice pre-law with 
an associate degree in journal-
ism and business administra-
tion.

She began her newspaper 
career at the McIntosh County 
Democrat and The Eufaula 
Indian Journal in 1999. She 
was promoted to advertising 
manager of the two publica-
tions in 2002 and to general 
manager in 2006.

In 2009, Jack and Jeff 
Mayo purchased the two 
McIntosh County newspapers. 
Today the Mayos publish 
nine newspapers in southeast 
Oklahoma under the company 
name Cookson Hills Publish-
ers, Inc.

At the two newspapers, 
Belyeu is responsible for 
day-to-day operations, sales, 
promotions and filling in as 
needed.

Belyeu was elected to the 
OPA board in 2018. Since 
then she has chaired multiple 
committees including Stra-
tegic Planning; Government 
Relations; Revenue and Pro-
motion; and Education. She 
is also a board representative 
for the Oklahoma Newspaper 
Foundation.

“During my time on the 
board, I have had the oppor-
tunity to meet so many great 
publishers from across the 
state and learn from some 
wonderful mentors,” said 
Belyeu.

Belyeu is also active in her 

community. She has served 
as secretary on the board 
of the Eufaula Chamber of 
Commerce for four years; as 
a member of the Eufaula Eco-
nomic Development Planning 
Committee; and is currently 
serving on the Eufaula Area 
Museum board.

Belyeu is a third-genera-
tion small business owner in 
Eufaula. Her daughter, Lauren, 
is also a small business owner 
in Tulsa.

Other officers elected for 
one-year terms at the business 
meeting were Suzie Campbell, 
publisher of the Countywide 
& Sun, as vice president, and 
Brian Blansett, publisher of 
The Lincoln County News, 
as treasurer. Gay will serve a 
one-year term as immediate 
past president.

The membership renewed 
a three-year board term for 
Shaun Witt, audience devel-
opment director at Oklahoma 
Watch, and Dee Ann Patter-
son, editor of The Lawton 
Constitution, was elected to a 
three-year term as a new board 
member.

Also on the board are Erin 
Dyer Thompson, El Reno Tri-
bune; Ed Choate, Muskogee 
Phoenix; Brett Wesner, Wesner 
Publications; and Connor Cho-
ate, Marietta Monitor.

NNA files 
complaints 
with PRC

The National Newspa-
per Association recently 
delivered letters from more 
than 200 newspaper titles 
to the Postal Regulatory 
Commission, complaining 
about inadequate mail 
delivery and escalating 
postage rates.

The comments were 
part of a review by the 
PRC of its postal rate 
regulations, which it is 
required by Congress to do 
periodically. The Com-
mission last completed 
a rate review in 2021 at 
which time it gave the US 
Postal Service authority to 
raise postage rates beyond 
inflation levels. The result 
for community newspapers 
has been an increase by 
35-50% in postage costs in 
the past four years.

The PRC announced 
earlier this year, following 
widespread complaints by 
mail users, that it would 
initiate a new inquiry on its 
regulations. Its determina-
tion will set USPS’s legal 
authority to increase rates 
for at least five years.

Shauna Belyeu elected as president

SHAUNA BELYEU

Continued on Page 4
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From the President
By Shauna Belyeu

Publisher of the Eufaula Indian Journal • OPA President 2024-2025

OPA CALENDAR 
OF EVENTS
For more information  

on upcoming events visit 

okpress.com/events

Thur., July 25
ADVANCED INDESIGN FOR 
DESIGNERS AND EDITORS 
– SCRIPTS, DATA MERGE 
& TABLES

During this 60-minute session, 
Kevin Slimp will be teaching 
skills to increase the speed of 
your productivity and quality of 
your design.

Thur., August 22
ARTIFICIAL INTELLIGENCE 
– WHAT NEWSPAPERS 
NEED TO KNOW

Don’t miss this chance to under-
stand what AI is, how it works, 
and other issues surrounding its 
use. Presented by Kevin Slimp.

Thur., October 31
OKLAHOMA JOURNALISM 
HALL OF FAME  
NOMINATIONS DUE

The Oklahoma Journalism Hall 
of Fame honors 9 to 12 indi-
viduals each year in the areas 
of print, broadcast and online 
journalism. Nominations must 
be submitted for consideration 
by the Hall of Fame’s selection 
committee. Letters of support 
from members of the community 
and industry provide additional 
weight to nominations.  

LIVE WEBINAR

    
      

   

               
                

                
            

                
              

      

FREE
for everyone 

including
nonsubscribers

• PRINT & DIGITAL SPEC ADS
• ARTICLES & RECIPES
• PUZZLES & HOROSCOPES
• SOCIAL MEDIA POSTS
• CUSTOMER REQUESTS
• FREE WEBINARS

& so much more

my newspaper

my newspaper #metrocreativegraphics

800-223-1600
service@metro-email.com
metrocreativeconnection.com

Visit metrocreativeconnection.com to see all we offer!

FREE
TRIAL
OFFER!

Davis Cordova is the new 
sports editor for The Ex-
press-Star in Chickasha.

Cordova attended the 
School of Media and Strategic 
Communications at Oklahoma 
State University, graduating in 
May with a degree in Sports 
Media.

While in college, he worked 
for The O’Colly, OSU’s stu-
dent newspaper, where he cov-
ered OSU football, women’s 
basketball and baseball.

Cordova new 
sports editor

Waxing nostalgic
We are in the final stages of 

moving to a new office. The 
thought of packing up a histor-
ical newspaper building might 
seem daunting, having to 
arbitrarily choose what stays 
and what goes. It is much 
like a competitive sport. You 
stretch, crack your knuckles 
and dive in.

I have moved homes a time 
or two and have helped clean 
out my grandmother’s 1920s 
house, which was quite a feat. 
I found so many things that 
gave me pause and took me 
down memory lane. 

Packing up a newspaper 
is like looking backward on a 
speeding train. You are look-
ing back at decades of news 
while speeding toward the 
next deadline. 

You must touch and 
evaluate every item. That 
also means one thing, you 
are digging up the proverbial 
time capsule that hides in the 

morgue and in the old desks of 
a newspaper office. 

Sometimes (many times) 
you get caught up with items 
that spark memories that take 
you down the rabbit hole. As 
I packed up items from my 
office, I found myself reflect-
ing on my journey. I still have 
an old rolodex filled with busi-
ness cards from over 20 years 
ago along with a welcome 
note from the town historian 
on my first day of work.

There are photos of 
employee’s newborn babies 
along with invitations to their 
college graduations 22 years 
later.

I found many things that 
have become obsolete through 
the years. The process is like 
a march through the decades 
filled with pica poles, PMTs 
and PageMaker. Time has a 
way of making things slowly 
fade away before you even 
realize it. The next thing you 

know, the only time that you 
use that pica pole is for a back 
scratcher.

One thing that is non-nego-
tiable is the decision to keep 
the many boxes of photos that 
sit in the old darkroom. They 
are full of photos that chron-
icle civic events, historical 
moments such as the Lake 
Eufaula Dam dedication and 
the demolition of a 100-year-
old building that collapsed. 
The photos will be sorted 
for historical importance and 
scanned. Until that day, they 
will stay tucked away in a 
newly organized office. 

As we shut the door for the 
last time to the old office, it 
feels a bit like uploading the 
final proof page to a commem-
orative edition and sending it 
to print. Now it is time to put 
this edition to bed and march 
on to the next issue.

I’m keeping the pica pole.



3    

July 2024 | The Oklahom
a Publisher

The Oklahoma The Oklahoma 
PublisherPublisher

ISSN 1526-811X

Official Publication of the
OKLAHOMA PRESS ASSOCIATION

OPA OFFICERS
President 

SHAUNA BELYEU 
The Eufaula Indian Journal

Vice President
SUZIE CAMPBELL 
Countywide & Sun

Treasurer
BRIAN BLANSETT 

The Lincoln County News

Executive Vice President
MARK THOMAS

OPA DIRECTORS
SHEILA GAY 

Past President, Woodward News

ERIN DYER THOMPSON 
El Reno Tribune

ED CHOATE 
Muskogee Phoenix

BRETT WESNER 
Wesner Publications

SHAUN WITT 
Oklahoma Watch

CONNOR CHOATE 
Marietta Monitor

DEE ANN PATTERSON 
The Lawton Constitution

OKLAHOMA PRESS ASSOCIATION 
3601 N. Lincoln Blvd.  

Oklahoma City OK 73105-5499
(405) 499-0020 

Toll-Free in Oklahoma: (888) 815-2672
www.OkPress.com 

news@OkPress.com 
www.Facebook.com/OKPress

SUBSCRIBE TO  
THE OKLAHOMA PUBLISHER

$12 PER YEAR

THE OKLAHOMA PUBLISHER (USPS 406-
920) is published monthly for $12 per year 
by the Oklahoma Press Association, 3601 
N. Lincoln Blvd., Oklahoma City, OK 73105-
5499. Periodicals postage paid at Oklahoma 
City, OK.

POSTMASTER: Send address changes to 
THE OKLAHOMA PUBLISHER, 3601 N. 
Lincoln Blvd., Oklahoma City, OK 73105-
5499.

You’ve Got Questions!
•	 Can I photograph minors without consent?

•	 Can police deny access to records by issuing  
a press release?

•	 Should I alter my archives when a person demands it?

•	 Can I report inaccurate testimony given in open court?

•	 What are the laws about liquor advertising?

These are questions answered by the attorneys for the OPA Legal Services  
Plan members in recent months. OPA members always need timely legal  
advice on issues related to publishing.

You should join OPA’s LEGAL SERVICES PLAN!
See OkPress.com/LSP or contact Mark Thomas  

at (405) 499-0033 or toll-free in Oklahoma 1-888-815-2672 today!

In a unanimous decision, 
the Oklahoma Supreme Court 
invalidated the results of a 
November 2022 lodging tax 
election in McCurtain County 
for failure to follow statutory 
publication requirements.

Statute Title 19 O.S. 2021 
§383 requires questions to 
the people “to be published at 
least four (4) weeks in some 
newspaper published in the 
county” if there is such a 
newspaper.

“The Legislature has 
mandated what constitutes 
notice by publication. Here, 
the statutorily required notice 
was not given. Anything less 
than strict compliance requires 
us to invalidate the election,” 
Justice Yvonne Kauger wrote.

In November 2022, voters 
of McCurtain County ap-
proved a ballot proposal of a 
lodging tax increase to fund a 
new county hospital. After the 
measure was approved, a lodg-
ing renter and property owner 

filed a lawsuit seeking to have 
the election declared null and 
void due to lack of newspaper 
publication.

The hospital and McCur-
tain County Board of County 
Commissioners sought to have 
the election upheld, citing 
numerous other measures of 
informing voters including 
social media, billboards and 
radio advertisements. The trial 
court judged in favor of the 
board and hospital.

The renter and owner ap-
pealed and filed a motion for 
oral argument. The Supreme 
Court retained the cause, 
denied the motion for oral ar-
gument and held that because 
the county commissioners 
neglected to follow the statu-
tory publication requirements, 
the voter-approved lodging tax 
increase is invalid.

The court also suggested 
the legislature update publica-
tion requirements. 

In response to this judicial 

editorial statement, OPA Ex-
ecutive Vice President Mark 
Thomas said, “While we agree 
with the court the election be 
overturned because the county 
failed to do the one thing 
the statute requires, we are 
dismayed the court hints that 
Facebook posts governed by 
secret algorithms, billboards 
encouraging a yes vote and 
civic club speeches could be 
the equivalent of a printed 
notice in the local newspaper.  

“OPA is working on mod-
ernization methods as several 
other states have done,” said 
Thomas. “However, funda-
mental principles of public 
notice, including publication 
by an independent non-gov-
ernment third-party, proof of 
publication, court verification 
and unaltered archives are 
paramount.”

(See Supreme Court  
opinion on OSCN.net:  
https://tinyurl.com/3sw6w69j)

Oklahoma Supreme Court invalidates 
McCurtain County lodging tax election
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Midwest City community 
thanks longtime reporter
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June 13, 2024 2:30 pm (GMT +0:00) 

By R.L. Thompson
 
 Okemah City Council 

approved for City Man-
ager Kristi Lesley to go 
out for bids to remove the 
buildings in the 500 block 
of West Broadway. 

This is not a new discus-
sion. The west wall of the 
building located at 514 
West Broadway collapsed 
in the early morning hours 
of October 6, 2023. The 
Housing Standards Board 
met on Tuesday, Novem-
ber 14, 2023, only three 
members were present to 
address the structures.  

Property Owner Tim 
Mander addressed the 
Housing Standards Board 
at their November 14, 
2023, meeting and said 
he wanted to save the 
property and develop the 
remaining buildings on 
the property. Mander em-
phasized that no interior 
walls were removed in the 
building.

Mander requested 120 
days to take down the 
building located at 514 
West Broadway. He re-
quested in the same 120 
days to remove the second 
story of brick on the build-
ing located just west of the 

Fire Department. He said 
the building is about three 
feet from the Fire Depart-
ment and the bricks would 
have to be removed by 
hand to keep from dam-
aging the fire department.  
Mander stated there was 
no structural damage to 
the center building and 
therefore, there is no dan-
ger to the public.  

Instead, Chairperson 
Shumate made the motion 
to abate all three build-
ings rejecting Mander’s 
offer and plan. The board 

voted 3-0 for Mander to 
take down all three build-
ings in 120 days.  The esti-
mated cost discussed dur-
ing the meeting could be 
around $60,000 to remove 
the buildings. Mander told 
the board that he could not 
cash flow that much money 
in just 120 days. The build-
ings were not demolished 
and are still standing today.

On March 25, the Oke-
mah City Council entered 
executive session to dis-
cuss a proposal concern-
ing the buildings located 

at 514 West Broadway.  
Upon return from execu-
tive session, Mayor Ron 
Gott made the motion to 
accept the buildings based 
on a marketable title be-
ing provide. Also, Mayor 
Gott noted the request was 
for the present owner Tim 
Mander to have until April 
29 to remove his personal 
items, Gott amended the 
request to April 19.  The 
Council voted unanimous 
to accept the buildings 
based upon the mayor’s 
motion.   The details of the 

agreement to accept the 
fallen buildings were not 
revealed in the motion nor 
discussed in opened ses-
sion.  

April 19 has come and 
gone and now seven 
weeks later the Council 
is still discussing the de-
molition of the buildings. 
There are still items in the 
building and in the lots to 
the west of the building 
that need to be removed. It 
was estimated during the 
Housing Standards Board 
meeting in November of 
last year, the buildings lo-
cated at 514 West Broad-
way would cost around 
$60,000 to take down.  

During the May 30 city 
council meeting the coun-
cil authorized Lesley to go 
out for bids. Vice Mayor 
Lucas asked about anyone 
seeking to reclaim some of 
the bricks. City Manager 
Lesley said it was part of 
the conversation.  The City 
does not have the funds in 
this budget year to abate 
the property. The new bud-
get will start in July; how-
ever, it has not been made 
public how much money 
the city is planning to allo-
cate for abatement projects 
in the next fiscal year.

Thursday, Jun 6, 2024
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Economic Development plan 
presented at TIF meeting

Disaster Recovery Center 
opened in Okfuskee County

The Tax Increment Dis-
trict Review Committee 
met on May 31 at Okemah 
City Hall to discuss next 
steps in creating a Tax In-
crement Financing (TIF) 
District in Okemah. At-
tending the meeting were 
Committee Members Ron-
nie Lucas, Tina Johnson, 
Randy Stubblefied, Vic 
Woods, and Lee Vick. Com-
mittee Member Melissa 
Farris was absent. At-Large 
Representatives attend-
ing were Andrew Benson, 
Sandra Golden and Roger 
Thompson. John Copeland 
was absent.

City Manager Kristy Les-
ley, City Clerk Relena Had-
dox, and Public Finance 
Law Group Representative 
Nate Ellis were present. 

As the city of Okemah 
moves forward in estab-
lishing a TIF District there 
are several steps. The first 
was a document review 
that occurred on May 31. 
There will also be a county 
meeting where a discus-
sion with the county com-
missioners explores po-
tential participation in the 
TIF District. A cost analysis 
to further define cost esti-
mates, including contin-
gencies for inflation and 

engineering. There will 
also be an opportunity for a 
public hearing for commu-
nity input on the proposed 
TIF district.

Nate Ellis reviewed three 
documents during the May 
31 meeting. They were 
(1) Proposed infrastruc-
ture improvements and 
related project costs; (2) 
Preliminary development 
assumptions and projected 
TIF Revenues and (3) Draft 
Okemah Economic De-
velopment Plan. Ellis ex-
plained the documents and 
requested committee mem-
bers to study and review 
the documents before the 
next scheduled meeting. 

The tax revenue dis-
cussed being used for 
economic development 
infrastructure would be 
newly generated tax from 
businesses located in the 
TIF District. Current tax 
revenue would remain the 
same for the taxing entities. 
At this point, the discus-
sion in the committee has 
been to only use fifty per-
cent of new tax revenue to 
cover the cost of infrastruc-
ture improvements and 
business incentives. The 
remaining fifty percent of 
newly generated tax would 

go to the taxing entities.  
The estimated project costs 
would be $7,900,000 that 
may be made available for 
improvements from appor-
tioned tax revenues. Or-
ganizational cost and debt 
service costs would be ap-
proximately $8,750,000 for 
a total of $16,650,000. 

According to the pro-
posed Economic Develop-
ment plan the TIF revenues 
are expected to finance all, 
or a portion of the project 
cost as discussed in the 
project plan. Based on the 
initial projections of As Va-
lorem increment revenues 
for the project is estimated 
that approximately $5.428 
million would be gener-
ated by the increment in-
crease in Ad Valorem tax 
revenue during the term 
(25 years) of the Increment 
District with approximate-
ly $2.714 million available 
for allocation to project 
cost, approximately $2.714 
million apportioned to the 
affected Ad valorem taxing 
jurisdictions. 

Based on the initial pro-
jections of sales tax incre-
ment revenues for the 
project, it is estimated that 

Okfuskee County 
Emergency Management 
Director Jim Bill Cope-
land issued the following 
release on Monday, June 
3.

Due to the recent Se-
vere Weather and Tor-
nado’s ( April 25 thru 
May 9, 2024) Okfuskee 
County has received a 
Disaster Declaration for 
Individual Assistance.  
As our previous posts 
have stated this is for any 
Homeowner, Renter or 
Occupant as well as any 

Business Owner in Okfus-
kee County that received 
damage caused by Se-
vere Weather, Tornado’s 
or Flooding.   FEMA and 
SBA (Small Business Ad-
ministration) has opened 
a Disaster Recovery 
Center in the Okfuskee 
County Fair Barn located 
at 1201 East Columbia in 
Okemah.  They are open 
each day from 8:30am 
to 5pm.  They will be in 
operation Monday thru 
Friday of this week.  We 
encourage everyone that 

is in-need of assistance, 
or you would like to visit 
with FEMA and or SBA 
go by the fair barn as soon 
as possible.   We do not 
know if they will be here 
any time past the end of 
this current week.   

If you have any ques-
tions you can message me 
on face-book or call me at 
918-716-0284.  

Thank You, 
Jim Copeland Director, 
Okfuskee County / 

City of Okemah Emer-
gency Management

By R.L. Thompson
 
Felony charges were 

filed in District Court in 
Okfuskee County on May 
31 against Lesley Renae 
Weeks for third degree 
burglary. 

Okemah Police Officer 
Stacey Rice filed the affi-
davit in this case. Accord-
ing to the affidavit, Of-
ficer Rice was dispatched 
on May 28 to 309 North 
Second Street in Okemah 
regarding a theft from a 
vehicle. 

Upon arrival, Officer 
Rice met with the vehicle 
owner, Brandon Wayne 
Ray. According to Ray, he 
was visiting an acquain-
tance at an apartment 
complex located at 201 
North 1st Street.

The affidavit states, 
“Ray parked his 1996 
Chevrolet truck at the loca-
tion and went inside. After 
the visit, Brandon exited 
the residence and entered 
his vehicle. He noted that 
his passenger door was 
partly open, and a small 
gift bag was missing. The 
gift bag was described as 
small and labeled with the 
words, Happy Birthday. 
The bag contained approx-
imately 30 empty cigarillos 
packaging and a stainless-
steel necklace pendant. 
The necklace is valued at 
approximately $40.”

The affidavit states 
that shortly before call-
ing the Police to report 
the theft, Ray,  “received a 
phone message from Les-
ley Weeks informing him 
that she witnessed an un-
known person getting into 
his vehicle while it was 
parked at the apartments.”

Officer Rice noted in 
his affidavit, that while on 
patrol in the area, he ob-
served prior to the incident 
being reported, Lesley 
Weeks sitting on the door-
step in front of apartment 
number four which was in 
proximity of Ray’s vehicle. 
Officer Rice also stated in 
the affidavit there was a 
red truck parked in front 
of apartment number four 
that was occupied by Pe-
ter Escalante. Officer Rice 
said from his perspective 
it appeared that Escalante 
was in conversation with 
Weeks.

Officer Rice stated in his 
affidavit that he made con-
tact with Lesley Weeks and 
she appeared to be very 

intoxicated, slurring her 
speech and swayed back 
and forth as she spoke 
with him. 

The affidavit states that 
Weeks denied seeing any-
one getting into Ray’s 
vehicle or getting into it 
herself. Officer Rice stated 
he planned to do a follow 
up interview when Weeks 
was sober. 

Officer Rice received 
new information from Ray 
regarding Escalante pos-
sibly witnessing Weeks in 
possession of a small bag 
that may have resembled 
the one taken from Ray’s 
vehicle.  The affidavit 
states that according to 
Escalante, he observed 
Weeks in possession of a 
small gift type bag while 
he was parked at the apart-
ment complex and as she 
was sitting on the doorstep 
of apartment number four.

Officer Rice obtained 
a brief written from Es-
calante and then located 
Weeks at her parent’s resi-
dence. Officer Rice said 
that Weeks still appeared 
very intoxicated while 
seated in a chair located 
in the driveway. Accord-
ing to the affidavit, Offi-
cer Rice noticed an open 
purse and in plain view, 
he observed a small gift 
bag labeled, Happy Birth-
day. The bag also con-
tained cigarillo packets.

When Officer Rice in-
quired about the items in 
her purse, Weeks denied 
taking them and stated 
an unknown Indian male 
with long hair had given 
her the bag. Weeks could 
not identify the male and 
said she had not seen him 
before. 

At this point, the affida-
vit states Weeks emptied 
her purse, and the gift bag 
was retrieved. There were 
29 cigarillo packets located 
as well as an empty jew-
elry box labeled stainless 
steel diamond snake pen-
dant. Weeks continued to 
deny taking the items.

Officer Rice received a 
call from dispatch about 
a burglary having just oc-
curred and he left this in-
vestigation to answer the 
call from dispatch. The af-
fidavit states when he re-
turned Lesley Weeks could 
not be located. 

If convicted burglary in 
the third degree is punish-
able by imprisonment for 
up to five (5) years.

Weeks charged with 
Third Degree Burglary

Cont. on pg. 6

Contact: Roger Thompson
Office: 918.623.0123
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The Midwest City com-
munity celebrated longtime 
staff writer Maxine Wheelan 
with a surprise celebration at 
the Nick Harroz Community 
Center on June 18.

Wheelan recently cel-
ebrated her 94th birthday 
and has been writing for 
local newspapers for nearly 
20 years, including at the 
Midwest City Beacon since 
2014 and Choctaw Times 
since 2010. 

She covers many com-
munity events, especially 
those involving veterans, 
law enforcement and senior 
citizens.

Midwest City Mayor Matt 
Dukes presented her with a 
citation proclaiming June 18 

as “Maxine Wheelan Day” in 
Midwest City.

“It’s about time we recog-
nized Maxine,” Dukes said. 
“She’s at more events than 
I am.”

Members of the Midwest 
City Police Department, Citi-
zens Police Academy Alumni 
Association, Midwest City 
Senior Center and realtor 
groups presented her with 
special plaques and spoke 
about her dedicated service.

“Anytime we need public-
ity for donations for any  
type of charitable cause, 
she’s our first call. She’s 
there to support everyone 
there and get it in the paper,” 
said Midwest City Police Lt. 
Laura Henry.

Midwest City Mayor Matt Dukes presents Maxine Wheelan with a procla-
mation declaring June 18, 2024, as “Maxine Wheelan Day” in Midwest City. 
(Photo by JEFF HARRISON, Midwest City Beacon, reprinted with permission.)

NNA Chair John Galer, 
publisher of the Journal-News, 
Hillsboro, Illinois, asked NNA 
members and newspapers in 
state newspaper organizations 
to send him their thoughts 
on the impact of the past few 
years of postage increases.

Responses registered a state 
of alarm on the future of the 
industry, specific complaints 
about delivery failures, losses 
of subscribers and unrespon-
sive local postal authorities 
when delivery was not prop-
erly executed. Galer included 
the letters in NNA’s comments 
to the Commission. 

NNA is also working with 
mailing partners on more 
detailed comments on the 
mechanisms involved in the 
rate regulation, including one 
provision that allows USPS to 
increase rates more when mail 
volume declines, which many 
in the industry consider a re-
ward for poor performance.

“NNA has met with the 
Commission recently to 
explain our situation,” Galer 
said. “We needed the Commis-
sioners to understand that this 
situation cannot continue. The 
PRC is inclined to blame the 
Postmaster General for using 
every inch of rate authority 
that the Commission extended. 

“But it was the Commis-
sion that laid the table for 
this disaster. With proper rate 
regulation, we would not be 
in the situation we now find 
ourselves in. Now, we have to 
be concerned not only for the 
future of our own newspapers 
but for the plummeting of mail 
volumes that threatens the 
very basis of universal mail 
service. 

“It was not unusual this 
year to see complaints not 
only about late newspaper 
delivery but also about checks 
in the mail arriving slowly 
or not at all. Even first-class 
mail has become unreliable in 
many areas.”

NNA Files
Continued from Page 1

Make sure you add a photo ID press card to 
your toolkit.
These press cards are perfect for reporters, 
photographers and other staff members at 
your newspaper. 

Only $7 each!

ORDER YOUR 2024  
PHOTO ID PRESS CARD

ORDER ONLINE AT  
okpress.com/press-cards
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We honor our commitment to strengthen our communities.

At OG&E, we do more than 
energize a power grid. 

North Rock Creek’s Maddox Motley, left, the defending Class 4A state champion, 
and Chandler’s J. Duncan, the defending Class 3A state champion, clear the final 
hurdle in the 110-meter event at the Chandler track meeting. Motley won.

Photo by BRIAN BLANSETT, The Lincoln County News, April 18, 2024

Cade Winter walks off the stage after his closing remarks.
Photo by ANDY DOSSETT, Bartlesville Examiner-Enterprise, May 24, 2024

Before the reopening of the iconic Rt. 66 Pony Bridge to the vehicle, the longest 
truss bridge in Oklahoma and on Rt. 66, visitors and locals could walk the length 
of the historic structure. 

Photo by BOONE CLEMMONS, The Country Connection News, May 15, 2024

APRIL 2024 WEEKLY WINNER:
BRIAN BLANSETT, The Lincoln County News

APRIL 2024 DAILY, SEMI- AND TRI-WEEKLY WINNER:
GLEN MILLER, El Reno Tribune

MAY 2024 WEEKLY WINNER:
BOONE CLEMMONS, The Country Connection News

MAY 2024 DAILY, SEMI- AND TRI-WEEKLY WINNER:
ANDY DOSSETT, Bartlesville Examiner-Enterprise

The April and May 2024 contests were judged by members 
of the Oklahoma  Journalism Hall of Fame.

View all winning photos and contest rules at  
OkPress.com/OGE-Photo-Contest

Enter and Win a $100 Check from OGE ENERGY CORP.
For more information about the photo contest,  

visit okpress.com/oge-photo-contest

El Reno sophomore Mason Fulton leaps out horizontally as he tries to catch a fly 
ball in the second inning of the Indians home game against Carl Albert. Fulton 
caught the ball but El Reno dropped the game. 

Photo by GLEN MILLER, El Reno Tribune, April 13, 2024
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DEATHS
ALEX K. ADWAN, retired 
senior editor of the Tulsa 
World, died June 15, 2024. He 
was 94.

Adwan was born April 14, 
1930, in Maud. He attended 
both high school and junior 
college at the Oklahoma Mil-
itary Academy in Claremore. 
After graduating from junior 
college in 1948, he continued 
his education at the University 
of Oklahoma where he earned 
his journalism degree in 1950.

Adwan then joined the 
Army and was commissioned 
as a second lieutenant. He 
served in Korea for more than 
two years. During his time 

there, Adwan was promoted 
to captain and was awarded 
a Bronze Star with a “V” for 
leading his company across 
enemy lines.

After returning from Korea 
in 1952, Adwan worked for 
several newspapers, including 
the Wewoka Times, the Pauls 
Valley Daily Democrat and 
the Seminole Producer, where 
he became co-publisher and 
managing editor. In 1960, he 
joined United Press Interna-
tional as bureau manager in 
Tulsa and was later promoted 
to bureau manager of Houston 
and Oklahoma City. 

Adwan joined the Tulsa 
World as Washington corre-

spondent in 1967 and reported 
on several major events during 
the late 1960s and early 1970s. 

In 1972, Adwan relocated 
to Tulsa when he was named 
as associate editor of the Tulsa 
World. He became editor of 
the editorial pages for the 
World in 1981 and held that 
position until his retirement in 
1994. In 1994, he was named 
senior editor. 

Adwan was inducted into 
the Oklahoma Journalism Hall 
of Fame in 1991; in 1995, he 
received the Oklahoma Press 
Association’s Beachy Mussel-
man Award. Adwan was also 
honored as a distinguished 
graduate of the University of 

Oklahoma School of Journal-
ism and the Oklahoma Mili-
tary Academy. He received the 
Oklahoma Education Asso-
ciation’s Marshall Gregory 
Award for Educational Media 
Excellence and was the 2001 
recipient of the RSU Constitu-
tion Award for his exemplary 
commitment to perpetuating 
the principles of the United 
States Constitution. 

Adwan is survived by his 
wife, Teresa, of Edmond; his 
sister, Elizabeth Robertson, 
and nephews Rob Robertson 
and Bruce Robertson, all of 
Edmond; and several great 
nieces and nephews.

CHARLES ‘CHUCK’ SIDNEY 
LAKE, former publisher of the 
Sapulpa Daily Herald, died 
July 11, 2024.He was 89.

Lake was born February 
22, 1935, in Claremore. The 
family moved to Muskogee in 
1945. 

After graduating from high 

school, Lake attended Musk-
ogee Junior College, gradu-
ating with an associate in arts 
degree in 1955.  

After graduation, he 
worked for the Muskogee 
Phoenix in advertising.  

He went to work at the 
Sapulpa Daily Herald in 1956. 
When the paper sold to Park 

Newspapers, Lake was named 
general manager. He worked 
his way up to division manag-
er overseeing close to 50 other 
newspapers across the country. 

In total, he worked at the 
Sapulpa Daily Herald for 41 
years.

Lake was a supporter of 
civic and community groups 

and received many honors. He 
was active in the Oklahoma 
National Guard  from 1955-
1964.

Lake is survived by daugh-
ters Beverly Susan and Carol; 
three grandchildren; and five 
great-grandchildren.

HARRISON ‘LYLE’ BECKER, 
former publisher of the 
Tonkawa News, died June 14, 
2024. He was 75.

Becker was born July 6, 
1948, in Enid. He attend-
ed college at Northwestern 
Oklahoma State University 
and then pursued a career in 

journalism. His first job was at 
the Claremore Daily Progress. 

He was married to Diana in 
1970 and had two daughters. 
The family moved to Cordell 
in 1978 where Lyle worked at 
The Cordell Beacon and even-
tually became the owner. 

In 1991, he sold the Beacon 
and moved back to Claremore. 
A year later, he became editor 

and publisher of the Bonham 
Daily Favorite in Texas.

In 1993, he bought The 
Tonkawa News and returned 
to Oklahoma. He owned the 
Tonkawa newspaper for 17 
years before selling it and 
moving to Fairview to be 
closer to his parents.

He later returned to Tonka-
wa to once again work at the 

Tonkawa News where he 
stayed until March 2024.

Becker is survived by two 
daughters, Kelli Hacker of 
Tonkawa and Kristin Estes 
of McKinney, Texas; seven 
grandchildren; 11 great-grand-
children; a brother, Lynn 
Becker of Owasso; and a 
sister, Lana Miles of Oklaho-
ma City.

Please donate to the  
OKLAHOMA NEWSPAPER FOUNDATION

Donations to the Oklahoma Newspaper Foundation will support its efforts to 
improve the state’s newspaper industry and quality of journalism.

Checks may be sent to 
OKLAHOMA NEWSPAPER FOUNDATION

3601 N. Lincoln Blvd., Oklahoma City, OK 73105-5499
or donate online at okpress.com/donations/

Remembering our friends  
& colleagues who died the previous year.

Darlene Howard 
July 19, 2023

Haskell Lee Gaither 
July 30, 2023

Thank you for your donation:

John & Sheila Gay
Thad Swiderski & eType Services
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DARRELL DION SUMNER, 
former owner and publisher of 
the Sapulpa Daily Herald, died 
July 1, 2024. He was 79.

Sumner was born April 29, 
1945, in Bartlesville. After 
graduating from high school, 
he attended Coffeyville Junior 
College in Kansas.

He began his 50-year career 
in the newspaper industry 
in 1970 at the Coffeyville 
Journal. Sumner also worked 
for newspapers in southern 
Arkansas before becoming 
publisher of the Poteau Daily 
News & Sun. 

In 1993, Sumner graduated 

from Arkansas Tech Universi-
ty and followed in his father’s 
footsteps working at the Spiro 
Graphic. He later purchased 
several newspapers in Missou-
ri and worked with his sons, 
Darren and Derek, and his 
brother, Don.

After selling several of 

their Missouri newspapers, the 
Sumner family purchased sev-
en newspapers in Oklahoma 
including the Sapulpa Daily 
Herald.

Darrell is survived by his 
wife Patty Sumner; sons Dar-
ren and Derek; brother Steve 
Nye, and two grandchildren. 

JOHN LOUIS SPIRE SR., a 
former sales representative for 
the Cushing Citizen, died June 
4, 2024. He was 87.

Spire was born June 6, 

1936. He attended Oklahoma 
State University and Central 
State University, receiving a 
master’s degree.

He served as a vocational 

minister in Arkansas, Kansas 
and Oklahoma.

Spire was a talented sales-
man with the Cushing Daily 
Citizen.

He is survived by his wife, 
Emma; son Doug Spire of 
Cushing; two grandsons; and 
four great-grandchildren.

DEATHS

Learn the best practices for Public Notices at 
okpress.com/public-notice-training
The Oklahoma Press Association offers three videos that describe and 
illustrate the standards and best practices for publication of notices 
along with downloadable material.

By John Foust
Greensboro, NC

I remember talking about 
sales presentations with 
Edwin, who is the marketing 
director of a regional adver-
tiser. “I’ve heard all kinds 
of presentations from media 
salespeople and I’ve asked 
plenty of questions during 
those conversations,” he said. 
“One of the best answers I’ve 
ever heard is, I don’t know. 
I’m not talking about I don’t 
know with a nonchalant shrug 
that says, ‘I don’t know and 
I don’t care’ or ‘That’s not 
my job.’ I’m talking about 
a sincere I don’t know that 
expresses regret that they hon-
estly don’t know the answer 
to the question. That kind of 
response is usually followed 
by a commitment to find the 
answer. They’re not trying to 
fool me with information that 
may be incorrect and they’re 
not trying to gloss over the 

question in order to move on 
to another sales point.” 

When said with unques-
tioned sincerity, I don’t know 
sends important messages. 
Let’s take a closer look. 

1. Respect. First of all, I 
don’t know shows respect for 
everyone involved – the pros-
pect, the prospect’s company, 
the salesperson’s company and 
the salesperson. 

You may remember the 
famous song “Respect.” Otis 
Redding wrote and recorded it 
in 1965, and Aretha Franklin 
recorded it two years later. 
Aretha added these lyrics, 
which have rocked through 
the ages: “R-E-S-P-E-C-T. 
Find out what it means to me. 
R-E-S-P-E-C-T. Take care of 
it. TCB.” 

TCB means, “Take care of 
business.” Believe me, there’s 
no better way to take care of 
business than to show genuine 

respect when meeting with 
prospects and clients. 

2. Honesty. We all appre-
ciate honesty. In fact, it’s safe 
to say that we require honesty 
in a relationship, whether it’s 
in our personal or profession-
al lives. When a salesperson 
readily admits that they don’t 
know the answer to every 
question that could possibly 
be asked, it establishes a new 
level of trust between the two 
people. Along the way, the 
prospect is more likely to take 
the salesperson’s words more 
seriously.

3. Opportunity. I don’t 
know is not a sign of weak-
ness. In reality, it represents 
a wide range of opportunities 
and puts the salesperson in 
position to be a hero. They can 
say, “I don’t know right now, 
but I’ll find out,” or “I can’t 
answer your question, but I’ll 
refer you to someone who can 
help,” or “I don’t know, but 

give me a minute to call my 
manager and see if there is 
some special information on 
that.” 

4. Confidence. It takes 
inner strength to say I don’t 
know. “When you express 
yourself with that kind of hon-
esty and commitment to help,” 
Edwin said, “it’s an impressive 
thing. As an advertiser, I want 
to deal with media represen-
tatives who believe in their 
products and in themselves. 
And I want them to have con-
fidence in the people around 
them.” 

The point is simple: There’s 
nothing wrong with saying I 
don’t know. It can be an open 
door to better client relation-
ships.  
© Copyright 2024 by John Foust. All rights 
reserved. Foust has conducted training pro-
grams for thousands of newspaper advertis-
ing professionals. Many ad departments are 
using his training DVDs to save time and get 
quick results from in-house training. Email 
for information: john@johnfoust.com 

There’s nothing wrong with saying ‘I don’t know’
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CHICKASAW NATION  
MEDIA RELATIONS

Loné Beasley
580-559-0921
lone.beasley@chickasaw.net
chickasaw.net

ETYPE SERVICES
Thad Swiderski
512-687-9055
thad@etypeservices.com
etypeservices.com

FEED THE CHILDREN
Carrie Snodgrass
(405) 213-9757
carrie.snodgrass@ 
	 feedthechildren.org
feedthechildren.org

GRAND RIVER DAM AUTHORITY
Justin Alberty
918-256-5545
justin.alberty@grda.com
grda.com

MENTAL HEALTH ASSOCIATION 
OKLAHOMA

Adi McCasland
405-250-6331
amccasland@mhaok.org
mhaok.org

METRO CREATIVE GRAPHICS
Jennifer Steiner
800-223-1600
jsteiner@metro-email.com
metrocreativeconnection.com

OGE ENERGY CORP.
Christi Woodworth
405-553-3698
woodwoco@oge.com
oge.com

OKLAHOMA ASSOCIATION OF 
ELECTRIC COOPERATIVES, INC.

Chris Meyers
405-478-1455
cmeyers@oaec.coop
oaec.coop

OKLAHOMA BAR ASSOCIATION
Janet Johnson
405-416-7000
janetj@okbar.org
okbar.org

OKLAHOMA DEPARTMENT OF 
REHABILITATION SERVICES

Jody Harlan, Comm. Director
405-203-1318
jharlan@okdrs.gov
oklahoma.gov/okdrs.html

OKLAHOMA MEDIA CENTER
Rob Collins, Executive Director
405-205-9421
rob@oklahomamediacenter.com
oklahomamediacenter.com

OKLAHOMA NATURAL GAS
Chad Previch
405-501-9509
Chad.Previch@onegas.com
oklahomanaturalgas.com

OKLAHOMA STATE SCHOOL 
BOARDS ASSOCIATION

Christy Watson, Comm. Director
405-528-3571
christyw@ossba.org
ossba.org

PHILLIPS THEOLOGICAL  
SEMINARY 

Kurt Gwartney
918-270-6470
kurt.gwartney@ptstulsa.edu
ptstulsa.edu

TULSA WORLD RECOGNIZES ALL-AWARDS WINNERS
The Tulsa World’s annual All-Awards recog-

nizes and honors some of the best in Tulsa-area 
high school sports.

Selections for the Athlete of the Year in high 
school varsity sports, along with other awards, 
were announced at the All-Awards Banquet on 

June 20 in the Cox Business Convention Center in downtown 
Tulsa.

Since 2017, the Tulsa World has awarded more than $170,000 
in scholarships to student-athletes at the event, and for the fifth 
year in a row, the All-World Awards were sponsored by Bill 
Knight Automotive.

Winners of the awards were featured in the Tulsa World.
The elite group of athletes is hand-selected by a panel of Tulsa 

World sportswriters. Athletes who qualify for nomination for an 
award are within 60 miles of downtown Tulsa, as well as athletes 
from a town of at least 5,000 people and located within 75 miles 
of Tulsa.

OKMULGEE TIMES HELPS COMMUNITY REPLACE FLAGS
After 22 American flags used to decorate a 

street were taken, the Okmulgee Times kicked 
off a drive to help replace them.

An anonymous donor dropped off a check for 
$200 at the newspaper office, which was  

presented to VFW Post 1189 Commander Guy Duckworth.
“I have renewed faith in people,” Duckworth said.
A box was placed at the Okmulgee Times’ office to accept 

new flags as well as monetary donations. 
The drive also sought to obtain small flags that are placed on 

the markers at the Okmulgee Cemetery during Memorial Day.

SEQUOYAH COUNTY TIMES ANNUAL RETIREMENT FAIR
The Sequoyah County Times’ 

annual Retirement Fair was held 
June 15 at the Sallisaw Middle 
School Cafeteria.

The travel-themed day of fun 
included door prizes, games, 
freebies and handouts, a free 
lunch and numerous vendors.

A 44-page tabloid chock-full 
of advertising included articles 
about local businesses and peo-
ple along with photos.

In addition to vendors, prizes, 
food and fun, the Sequoyah 
County Times gave away a total 
of $500 in Bingo cash prizes.

THE COUNTRY CONNECTION NEWS IS ON THE MOVE
The Country Connec-

tion News will soon be 
moving to Hinton. 

The new space, which 
will include a podcast  
studio and an archives 
room, will be located at 107 E. Main.

Beginning in August, the weekly newspaper plans to expand 
its 42-year history of covering school news with the help of a 
student journalism program. 

Each school the newspaper covers will name one or more 
student journalists, said Publisher Cory D. Cart. 

The schools will have one to two full pages of news each week 
during the school year with content produced by the students.

  2024 RETIREMENT FAIR • 1SEQUOYAH COUNTY TIMES

2024 2024 
Retirement Retirement 

FairFair
Adventure AwAitsAdventure AwAits

Worth Mentioning
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Several months ago, the 
Mangum Star News asked 
Greer County residents what 
they wanted to see in their 
hometown newspaper. Now, 
Editor Mike Bush is delivering 
what they asked for.

On the front page of a 
recent edition there were four 
pictures and eight stories 
covering a wide range of local 
topics including:
• 	A meeting of county 

commissioners and the 
Mangum City Council to 
work on details for a new 
county detention center.

•	 Greer County and Oklaho-
ma election results.

•	 A chamber of commerce 
ribbon cutting at a local bed 
& breakfast.

•	 Two individuals being ar-
rested after trying to make 
an illegal drop of tobacco, 
marijuana vapes and other 
items at the state reformato-
ry in Granite.

•	 The American Legion Post 
hosting a flag retirement 
ceremony.

•	 Independence Day celebra-
tions planned in Mangum 
and Granite.

•	 The annual town of Lone 
Wolf celebration event 
schedule.

•	 Free performances by the 
most advanced Oklahoma 
high school artists at nearby 
Quartz Mountain State 
Park.
Bush gets an A+ for doing 

what the paper’s readers want, 
and reporting about what has 
happened, what is coming up 
and about the local people and 
businesses it serves.

Austin Litterell provided 
excellent coverage in The 
Express-Star in Chickasha of 
the University of Science & 
Arts of Oklahoma’s trek to the 
NAIA Softball World Series.

Litterell’s combination of 
reporting the playoff games 
leading up to the World Series, 
feature stories on individual 
team players and exceptional 
photography made readers 
feel like they were part of 
the excitement when USAO 
advanced to the national tour-
nament.

Even though they didn’t 
come home with the title, 
Litterell did a superb job of 
recapping the stellar season 
by making sure Express-Star 
readers understood what the 
USAO Drovers accomplished.

“The Drovers have shown 
the ability to fight back,” 
wrote Litterell. “To make it 
through a season as long as 
the college softball season, 
resiliency is an intangible that 
can take teams a long way. 

And that has been the case 
for the University of Science 
& Arts of Oklahoma softball 
team this season. The Drov-
ers have faced adversity and 
have shown resiliency during 
the season, especially during 
the team’s run in the NAIA 
Softball World Series loss to 
top-seeded Our Lady of the 
Lake University.”

Last month the Stigler 
News Sentinel helped build 
excitement for the 57th Annu-
al Reunion Days.

A 16-page special section 
lets readers know about the 
upcoming events including a 
weekend with class reunions, 
food, arts and crafts, games, 
music and even terrapin races.

It also featured many 
well-designed ads, class 
pictures from high school 
yearbooks for each 10-year 
interval from 1964 to 2014, 
hometown pride stories,  
pictures of new construction 
projects that are underway and 
a picture page from last year’s 
reunion.

The News Sentinel also did 
a good job with its 2024 Pri-
mary Election Voter’s Guide.

Whether it was candidates 
running for county commis-
sioner, county clerk, state 
corporation commissioner or 
their state representative, it de-
livered a concise easy-to-read 
and understandable format that 
compared the views of each 
candidate.  

The Watonga Republican 
also did excellent educational 
reporting on its local elections. 
In the edition that carried the 
“Meet the candidates for sher-
iff” story, it also did a separate 
story titled, “Why is the elec-
tion for sheriff important?” 

Connie Burcham’s column, 
“A Bubble Off Plumb” about 
the time she was in Hell made 
me chuckle.

“I spent three weeks in Hell 
once,” wrote Burcham. “You 

might wonder how one gets to 
Hell. I rode in atop an 18-hand 
red mule named Moe. Let me 
elaborate. I had been hired as 
camp cook for an outfitter in 
Hell’s Canyon, Idaho.” 

She goes on to detail her 
experience in Hell and the 
wonderful people she met 
there. 

“I even made a little mon-
ey, and it gave me the perfect 
answer if someone should tell 
me to go to Hell. I’ll just say, 
‘When can we leave?’”

The Buffalo Weekly News 
does an excellent job in get-
ting the news to the town of 
less than 1,000 residents in far 
northwest Oklahoma.

Printed in-house in full 
color on book paper, the News 
regularly has 20 pages, on an 
8.5 X 11 inch format, that are 
filled with news, columns, 
feature stories, sports, legal 
notices, calendar of events 
– and dozens of ads in every 
edition. 

While it may not be printed 
in a traditional manner, it is 
truly a newspaper that serves 
its community well.

TOP FIVE HEADLINES:
5.	 “We Are Broke And  

Broken”  
– Sulphur 
Times-Democrat

4. 	 Naked Lady Dons Her 
Duds Before Valliant 
Police Arrive     
– The Valliant Leader

3.	 Everybody is going  
to jail  
– Atoka County Times

2.	 WHO’s sorry now?    
 – Sequoyah County Times

1.	 Pryor High-jinks:  
60 seniors detained   
– The Paper

Looking  
Them Over
by Rod Serfoss

rserfoss@okpress.com

Mangum Star News changes for its readers

OPA Business Consultant Rod  
Serfoss looks over OPA member 
publications for “Looking Them Over,” 
a monthly column. To contact  
Serfoss, email rserfoss@okpress.com.

mangumstarnews.com  | SERVING YOU SINCE 1887FRIDAY, JUNE 21, 2024 $1.00
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Mangum Lions Club presents awards PAGE 7

BY MIKE BUSH
editor@mangumstar.com

The Greer County Commis-
sioners met in a special meet-
ing Monday with the Mangum 
City Council to work on details 
involving the plan for the new 

Greer County Detention Cen-
ter. 

Sheriff  Steve McMahan and 
his staff  have been working on 
this project since November of  
2023. Once the fi nal details of  
the jail fl oor plans, costs and the 
options regarding how to pay 

for a new facility were worked 
out, he began meeting with the 
City Council and Mangum City 
Manager Erma Mora in trying 
iron out the details regarding 
the City of  Mangum deeding 
the Armory to the County to be 
able to utilize it for the new de-

tention center. 
“I’ve enjoyed working on this 

project for the last 8 months,” 
said Sheriff  McMahan. “It’s 
something that’s been needed 
in Greer County for a very long 
time. This has been the clos-
est we’ve ever been to getting 

a new facility, and I’m excited 
to be able to work with the City 
leaders to make this opportu-
nity happen.” 

An agreement was made 
Monday between the two 
boards that the City of  Mang-
um will transfer the Armory 

to the County to refi t the struc-
ture and grounds to be utilized 
as a County Jail. The County 
will in turn waive all booking 
fees associated for any munici-
pal inmates booked in at the 

BY MIKE BUSH
editor@mangumstar.com

Little did Kassi Loubser 
know that when she and her 
fi ancé, (now husband) Eugene, 
got married at The Outside 
Inn, that exactly a year and 
day later they would own the 
bed & breakfast located at 503 
N. Louis Tittle in Mangum. 
The Mangum Chamber of  
Commerce held a ribbon cut-
ting ceremony at The Outside 
Inn this past Friday for the 
Loubsers.

The Outside Inn is a beau-
tiful bed & breakfast that can 
accommodate several guests 
in unique rooms such as the 
Rose Room, Juniper Room 

The American Legion Post 
121 will be doing a Flag Re-
tirement Ceremony today 
at the Pavilion behind the 
American Legion building 
at around 6:30 PM. Anyone 
wishing to retire their old US 
Flags should bring them to 
the American Legion so we 
may include them.

A fl ag retirement ceremo-
ny is a solemn and dignifi ed 
event where a worn or dam-
aged American fl ag is respect-
fully retired from service. The 
purpose of  a fl ag retirement 
ceremony is to honor the fl ag 
and the country it represents, 
while also ensuring the fl ag 
is disposed of  in a respectful 
and dignifi ed manner.

In a typical American Le-
gion fl ag retirement ceremo-
ny, the fl ags that are no longer 
serviceable are presented to 
Legion commanders, who in-
spect them to make sure they 
should, in fact, be discarded. 
When it’s agreed upon that 
they’ve reached their current 
worn state due to proper ser-
vice of  tribute, memory and 
love, a color guard presents 
the colors, and a chaplain of-
fers prayers. 

As the crowd renders hon-
ors, the fl ag detail dips the re-
tired fl ags into kerosene and 
puts them on a rack over the 
fi re.   Once all the fl ags have 
been burned, the ashes are 
buried.

BY MIKE BUSH
editor@mangumstar.com

Two individuals were ar-
rested and booked into the 
Greer County Detention Cen-
ter after trying to make an 
illegal drop of  tobacco, mari-
juana vapes and other items 
at the Oklahoma State Refor-
matory in Granite on June 12. 

According to Greer County 
Sheriff  Steve McMahan, the 
Greer County Sheriff’s Offi ce 
was requested to assist Gran-
ite Police offi cers in the early 
morning hours of  June 12, 
and upon arrival with District 
3 Drug and Violent crime task 
force agents, a K- 9 unit was 
deployed and uncovered 2 
packages containing tobacco 
and marijuana vapes along 
with packing supplies and 

camouflage 
clothing in-
side the sus-
pect’s vehicle. 

N i c h o l a s 
Hunt, 30, of  
Drumright, 
and Heather 
Thomas, 36, 
of  Manford, 
were arrested 
and booked 
into the Greer 
County De-
tention Cen-
ter pending 
charges of  
Possession of  
CDS with In-

tent to Distribute, Conspiracy 
to Commit a Felony and Intro-
duction of  Contraband into a 

BY MIKE BUSH
editor@mangumstar.com

Independence Day cel-
ebrations will be held in both 
Mangum and Granite, with 
Mangum’s on July 4 and 
Granite’s on June 29.

The Mangum celebration 
is being held at the Red River 
Cowboy Church and will in-
clude free hot dogs and wa-
ter, Sweet Island Ice snow 
cones, and a fi reworks show. 
Gates will open at 7:30 PM 
and the fi reworks show will 
begin at dusk. The Red River 
Cowboy Church is located at 
1001 N. Byers Ave. The event 
is being sponsored by the 
Red River Cowboy Church 
along with T&S Lawn Ser-
vice, Terry and Shawn 
Whetstone, the Greer Coun-
ty Sheriff’s Department, 333 
Dental Care, Greer County 
EMS, Mangum Fire Depart-
ment, and the Greer County 

Economic Trust.
The Granite Fire Depart-

ment is hosting their Indepen-
dence Day Celebration on Sat-
urday, June 29 with vendors, 
a softball tournament, dunk 
tank, parade, and fi reworks 
show.

The softball tournament 
will be held from 9 AM to 1 
PM. Cost is $25 per team of 11. 
To sign up, contact Brittany at 
brit.granitefi re@gmail.com 

There will also be free 
swimming offered from 1 to 
6 PM, with vendors set up 
across from the pool.

The Granite Fire Depart-
ment’s 3rd annual 4th of  July 
Parade will start at 6 PM, and 
free hot dogs will be offered 
from the Town of Granite at 7 
PM. The Lions Club will also 
be offering ice cream fl oats at 
8 PM.

The fi reworks display put 
on by the Granite Fire Depart-
ment will be held at dusk.

The annual Lone Wolf  Cel-
ebration will be tomorrow, 
Saturday, June 22 with a full 
day of  events planned.

Events include a side-
walk chalk art contest, face 
painting, ballon creations, 
caricatures and over 20 ven-
dors. Plenty of  food trucks 

will also be there including 
Rene’s Gourmet and the Surf  
Bar West. There will also be 
a Cornhole Tournament and 
Turtle Race. The Main Street 
Parade, led by the 77th Army 
Band is always a highlight. 
The parade will be followed 
by live music featuring lo-

cal band “Say What?” along 
with special guests DJ Richie 
Rodriquez and everyone’s fa-
vorite “Elvis”, Kris Rambler. 
The best fi reworks display in 
SW Oklahoma is also prom-
ised and will begin at dark.

Schedule of  Events:
7:30-9:30 a.m., Pancake and 

Sausage Breakfast at Senior 
Center

11:00 a.m., Sidewalk Chalk 
Art Contest in Larry West 
Park

11:00 a.m., Alumni Lunch
12:00 p.m., Food Trucks 

LONE WOLF - Every 
year, thousands travel to 
Quartz Mountain State 
Park & Lodge to enjoy free 
public performances dur-
ing the Oklahoma Summer 
Arts Institute (OSAI). This 
year’s OSAI will feature 
performances by the most 
advanced high school art-
ists in Oklahoma, as well 
as faculty and guest artists 

from around the world.
OSAI culminates in On-

Stage Weekend, June 22-23, 
where students from each ar-
tistic discipline will be show-
cased in fi lm screenings, a 
gallery opening, a poetry 
reading, and music, dance, 
and acting performances.

The campus opens to the 
public at 9 AN with the gal-
lery opening in the Amphi-

theater from 10-11 AM. A 
Chorus Concert will be held 
from 1:30-2:30 PM, a Poetry 
Reading and Film Screen-
ing will take place fro 3-4:30 
PM, and an Orchestra Con-
cert will take place from 8-9 
PM. On Sunday, the campus 
opens to the public at 8 AM 
with closing ceremonies 
taking place from 10-11 AM.

All lectures and perfor-

mances take place in the Rob-
ert M. Kerr Performing Arts 
Center at the Quartz Moun-
tain State Park & Lodge in 
southwest Oklahoma. Seat-
ing is on a fi rst-come, fi rst-
served basis, with doors 
opening thirty minutes prior 
to each event. 

For more information, vis-
it www.oaiquartz.org or call 
405-605-7500. 

BY MIKE BUSH
editor@mangumstar.com

The Oklahoma Primary 
Election was held Tuesday 
with Greer County voters 
only having a Republican 
ballot. The two races on 
their ballots were for Cor-
poration Commissioner 
and United States Repre-
sentative District 3.

In Greer County, for Cor-
poration Commissioner, J. 
Brian Bingman received 
64.94% of the votes with 113, 
Justin Hornback received 
43 votes, and Russell Ray 
received 18 votes.

For United States Repre-
sentative District 3, Frank 
D. Lucas received 77.27% of  
the votes with 136, Darren 
Hamilton received 22 votes, 
and Robin Lynn Carder re-
ceived 18 votes.

These numbers are unof-
fi cial ballot counts posted 
by the Oklahoma Election 
Board as of  Wednesday, 
June 19. Election results 
are posted to this website 
as they are received at the 
Oklahoma State Election 
Board from county election 
boards and will not include 
provisional ballot results 
until after 5 PM today.  Re-
sults shown here are sub-
ject to contest and recount 
and are neither fi nal nor of-
fi cial until they are certifi ed 
by the appropriate election 
board.All Greer County 
offi ces up for re-election 
ran unopposed. They were 
Steve McMahan for Sher-
iff, Jenna Scott for Court 
Clerk, Tiffany Buchanan 
for County Clerk, and Mark 
Barnes for County Com-
missioner District 2.

Agreement fi nalized for new County Detention Center
Future plans for dispatch center also agreed upon

The Mangum Chamber of Commerce held a ribbon cutting for the new owners of The Outside Inn Bed 
& Breakfast this past Friday. Holding the scissors is Kassi Loubser, at her right is husband Eugene, 
and at her left is her daughter Alexas Kendall.

Ribbon cutting held for new 
owners of The Outside Inn

Suspects arrested in illegal 
contraband drop at OSR

HEATHER 
THOMAS

NICHOLAS 
HUNT

Flag Retirement Ceremony to be 
held today at American Legion

Independence Day celebrations 
set in Mangum and Granite

Greer County 
Primary 
Election 
results given

OSAI OnStage Weekend happening at Quartz Mountain

Annual Lone Wolf Celebration being held tomorrow

SEE AGREEMENT, PAGE 2

SEE ARRESTED, PAGE 2

SEE WOLF, PAGE 2

SEE RIBBON, PAGE 2
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By Austin Litterell 
The Express-Star

The University of 
Science & Arts of Okla-
homa softball team has 
a motto.

“Why not us?”
And so far this post-

season, that motto has 
benefited the Drovers.

The Drovers entered 
their conference tourna-
ment having won 21 
games in a row to end 
the regular season. They 
now have won 28 games 
in a row, captured a 
conference tournament 
title and are heading 
back to their third con-
secutive NAIA Softball 
World Series.

The Drovers were the 
No. 2 seed entering the 
Sooner Athletic Confer-
ence’s postseason tour-
nament and the sixth-
ranked team in the 
country. They went 4-0 
in the tournament, tak-
ing down top-seeded 
and second-ranked 
Oklahoma City Univer-
sity in the champion-
ship game.

Then, the Drovers 
hosted the NAIA Soft-
ball National Champi-
onship Opening Round 
and were the top seed in 
the bracket last week. 
They lived up to that 
seed.

Science & Arts went 
3-0 in the bracket to 
secure the team’s spot 
in the World Series. 
They took down 
fourth-seeded Baker 
University once before 
beating second-seeded 
and 12th-ranked Mid-
land University twice to 
advance.

The Drovers picked 
up a 5-3 win over Baker 
before a 5-4 win and 

8-0 run-rule win over 
Midland. Science & 
Arts is 9-0 in its last 
three NAIA Opening 
Rounds.

“It’s my third year at 
USAO, and I’m going 
on my third trip to 
Columbus which just 
shows you how good 
our program is,” junior 
Sierra Selfridge said.

Resilient Drovers

Science & Arts faced 
some adversity in its 
first two games this 
week, falling behind in 
both of those games 
before rallying to pick 
up wins. Baker held a 
3-0 lead Tuesday, and 
Midland held a 3-1 lead 
in the teams’ first meet-
ing the following day.

But the Drovers’ men-
tality paid off.

“Why not us?”
“We got down 3-0, 

but we just had to keep 
fighting because it’s not 
over until the last out in 
the bottom of the sev-
enth,” Selfridge said.

Selfridge stepped up 
with the bases loaded 
and two outs in the bot-
tom half of the fifth 
inning and delivered. 
With one swing of the 
bat, Science & Arts took 
the lead.

“I told myself in the 
on-deck circle that if 
[Macenzie] Ruth got on 
it was go time,” she 
said. 

And sure enough, 
Ruth got on base to load 
the bases. Selfridge 
then crushed a grand 
slam over the cen-
ter-field stretch of fence 
to put the Drovers ahead 
4-3.

“I took the first pitch. 
The next pitch was ele-

vated in the middle of 
the strike zone, so I 
swung,” Selfridge said.

Freshman Leighanne 
Eaton hit an RBI double 
in the same inning, and 
freshman Jayden Ander-
son stepped up in relief 
to earn the first of her 
two wins in the circle 
during the Opening 
Round.

And, just like in the 
first game, Science & 
Arts had to come back 
in its second game.

The Drovers trailed 
3-1 entering the bottom 
half of the third inning, 
but they kept battling 
and came up with anoth-
er answer by scoring 
three runs in the inning. 
An Eaton homer gave 
the Drovers a 1-0 lead 
before the team fell 
behind.

She played a role in 
the team retaking the 
lead, hitting a go-ahead 
sacrifice fly to make the 
score 4-3. A Malea 
McMurtrey double put 
the Drovers up 5-3, but 
before all of that came 
another clutch hit.

Selfridge brought in a 
pair of runs with a base 
hit that tied the game at 
three runs apiece. Self-
ridge had six RBIs and 
six hits in the three 
games.

Anderson earned 
another win in the cir-
cle.

Big win

The Drovers entered 
Thursday needing just 
one win to advance to 
the World Series. They 
had no problem getting 
that done.

Five runs in the bot-
tom of the third inning 
propelled the Drovers to 

an 8-0 run-rule victory 
over Midland. Sophie 
Williams threw five 
shutout innings in the 
circle and had two 
RBIs at the plate to 
help the Drovers.

It was the end to 
another successful 
week.

“We faced some 
really good teams this 
week, but we came 
out on top,” Selfridge 
said.

World Series

The Drovers will 
now head to Colum-
bus, Georgia, where 
they are the No. 6 seed 
in the bracket. They 
will face No. 3 seed 
Central Methodist 
University at 6 p.m. 
Thursday.

Resilient Drovers 
advance to World 

Series

Science & Arts celebrates advancing to the NAIA Softball World Series after May 16’s win in Chickasha. 
Austin Litterell/The Express-Star

By Austin Litterell 
The Express-Star

Sierra Selfridge was not going to let her team 
lose.

The University of Science & Arts of Oklahoma 
junior delivered a red-hot NAIA Softball National 
Championship Opening Round in Chickasha last 
week, helping the Drovers advance to the NAIA 
Softball World Series for the third season in a row. 
The Drovers went 3-0 as the top seed in the bracket.

Both Baker University and Midland University 
had all sorts of problems trying to get Selfridge out 
at the plate, and she made those teams pay by going 
6 for 9 at the plate with six RBIs in three games. 
Maybe more important than the number of hits was 
the timing of a couple of her hits.

All six of Selfridge’s RBIs came with the team 
trailing and came on two hits. One of those hits 
gave the Drovers a lead against Baker, and the sec-
ond of those two hits tied one of the games against 
Midland.

In Tuesday’s 5-3 win over Baker, the Drovers 
found themselves in a 3-0 hole entering the bottom 
of the fifth inning. Selfridge made the opponent 
pay after Kinzie Williams, Malea McMurtrey and 
Macenzie Ruth got on base to load the bases with 
two outs.

Selfridge said she went up to the plate wanting to 
be patient and eventually got an elevated pitch in 
the zone. She took advantage of that by mashing a 
grand slam to center field and giving the Drovers a 
4-3 lead.

It was a moment Selfridge will remember for a 
long time.

“I had to be patient because she was throwing a 
lot of balls,” Selfridge said. “Hitting the go-ahead 
grand slam will be something I will remember for-
ever.

“The excitement from my team and the fans 
showed me they had my back, no matter what the 
outcome was, and I had theirs.”

The Drovers then trailed 3-1 in the bottom of the 
third inning against Midland the following day, and 
Selfridge stepped up again. McMurtrey and Ruth 
delivered back-to-back singles after a Williams 
walk to set Selfridge up, and she hit a two-run sin-
gle to tie the game at three runs apiece.

It was another shining moment for a player want-
ing to step up as a leader on a team dependent on a 
group of several sophomores and freshmen.

“We are a very young team this year, so I had to 
step up and take on a bigger leadership role,” Self-
ridge said.

The junior is hitting .418 with eight home runs 
and 57 RBIs.

Selfridge shines in 
run to World Series

Sierra Selfridge celebrates a base hit during May 16’s win in 
Chickasha.

Austin Litterell/The Express-Star
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is just one of the benefits of being a member of the Oklahoma Press 
Association’s Legal Services Plan. Remove the worry of needing  
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION’S 
LEGAL SERVICES PLAN 

1-888-815-2672 or 405-499-0020

OPA Computer Consultant Wilma Newby’s 
column is brought to you by the Oklahoma 
Advertising Network (OAN). For more 
information on the OAN program,  
contact Oklahoma Press Service at (405) 
499-0020.

With a lot of new ad  
designers in the state, here’s 
some tips for creating ads in 
InDesign.

To start, go to File > Docu-
ment Preset to create standard 
ad sizes. Use the new or edit 
buttons to create new ad sizes 
or edit existing sizes if your 
column width changes.

In the next box, uncheck 
Facing pages and put in the 
width and height of the ad 
you’re building. Add the num-
ber of columns and make sure 
there is no margin around the 
ad; set all margins to 0.

After making sure the ad 
sizes are correct, click OK.

Make as many templates 

as you need, putting them in 
order. For example, place all 
the two column ads, then the 
three column and so on. This 
makes the new list of ad sizes 
easy to navigate.

Now when you’re ready to 
start a new ad, just go to File > 
Document Preset and select an 
ad size from the menu. 

Next, draw a border on the 
ad, if you want one, making 
sure it stays inside the ad’s 
exterior lines.

If you need to make a 
polygon, elliptical or starburst, 
look under the Rectangle tool 
flyout menu. 

When the Polygon tool is 
double-clicked, it gives you a 
menu that lets you choose the 
number of points and inset of 
a starburst. 

If your ad needs rounded 
or fancy corners, look under 
Object > Corner Options... You 
can pick from several styles 
in the menu. By unchecking 
the lock in the middle of the 
dialog box, you can make just 
one or two corners different.

The Stroke palette is a good 
place to explore for differ-
ent types of creative border 
options. It’s even possible to 
create a new line style for the 
ad you’re working on. Arrows 
and such are under the Start/
end dropdown button. The line 

must be highlighted on the 
page to see these effects.

Keep the ad neat. Try to 
keep all text boxes in the ad 
area and not hanging over on 
the pasteup board. This can 
cause printing errors.

If the ad is designed by 
more than one person, avoid 
use of white boxes without 
borders. They, too, can cause 
problems. 

Another tip is to try using 
gradients to fill the back-
ground. Gradients can be 
created in the Swatches palette 
with the flyout menu > New 
Gradient Swatch. Select the 
sliders under the gradient to 
change the color. And always 
work in CMYK mode.

Use Object Effects to styl-
ize the type or boxes. For art 
that is a picture go to Objects 
> Effects > Transparency. Here 
the art can be lightened so any 
type over it is readable. Use 
larger type for this kind of 
work. 

Learn to use the Eyedrop-
per tool in InDesign to find 
the values of colors used in 
the art. Use those values for 
headlines, boxes or other areas 
of your ad.

Use the Object > Clipping 
Path to clip backgrounds from 
art. This works best with 
simple art. The checkbox 
for preview is very helpful. 
Checking Include Inside Edges 
gets rid of white space within 
the art. 

For copy, use the text 
tool or bring it in from other 

sources with the File > Place 
command.

File > Place can bring in 
external art as well as type. It 
gives more control over how 
the image or type is imported 
into the layout. Check the 
Show Import Options box to 
bring up lots of options.

After art is imported always 
go to the Links palette and 
embed it by right clicking and 
going to embed in the con-
textual menu. Flatten all art 
used to a Tiff or JPG file and 
convert the art to CMYK. 

Several software programs 
will prepare a photo for press 
by turning the output color 
format to CMYK. If you don’t 
have Photoshop, consider us-
ing the popular Krita — a ba-
sic paint program that converts 
art from RGB to CMYK. This 
open source software is free 
for Windows, Linux or Mac. 

When your ad is complet-
ed, select the black pointer 
tool, then hold down the Com-
mand key and hit the (A) key to 
see all objects on the page. 

Now eliminate any text or 
art boxes that don’t belong. 
For text boxes, look for little 
blue dots. 

To select all elements,  
highlight the area. Then, hold 
down the shift key and dese-
lect everything that should 
be in the ad. To get rid of all 
the elements that shouldn’t be 
in the ad, hit the delete key. 
If you delete something that 
should be there, use Command 
Z (undo), to start over.

Before you place the ad on 
the page, make sure it has the 
advertiser’s contact informa-
tion — phone and/or email. 
You’d be surprised how many 
times those elements  are 
missing and the reader has no 
way to contact the advertiser. 

Tips for new designers creating ads with InDesign
Computer Notes

from the road
by Wilma Newby

wnewby@okpress.com
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OPA STAFF DIRECTORY

The Oklahoma Press As-
sociation Board of Directors 
met at the Sheraton Downtown 
Hotel in Oklahoma City on 
June 7.

Officers attending were 
President Sheila Gay, Wood-
ward News; Vice President 
Shauna Belyeu, The Eufaula 
Indian Journal; and Treasurer 
David Stringer, The Lawton 
Constitution.

Directors attending were 
Zonelle Rainbolt, Past Pres-
ident, Wesner Publications; 
Suzie Campbell, Countywide 
& Sun; Erin Dyer Thomp-
son, El Reno Tribune; Brett 
Wesner, Wesner Publications; 
Shaun Witt, Oklahoma Watch; 
and Connor Choate, Marietta 
Monitor. Ed Choate, Muskogee 
Phoenix, was unable to attend. 

Also attending were guests 
Brian Blansett, The Lincoln 
County News, and Dee Ann 
Patterson, The Lawton Consti-
tution.

OPA staff at the meeting 
were Executive Vice President/
Secretary Mark Thomas and 
Member Services Director Lisa 
Sutliff. 

After calling the meeting to 
order, Gay asked the board to 
review the minutes of the April 
11, 2024, meeting. The minutes 
were approved as presented.

The board reviewed OPA 
and LSP financial statements as 
of April 30, 2024. Stringer said 
revenue and expenses were 

both higher than budgeted as of 
April 30. LSP revenue declined 
slightly, and professional ser-
vices increased for defense of a 
current lawsuit.

After reviewing the OPA 
and LSP investment reports as 
of April 30, 2024, the board 
acknowledged receipt of the 
financial statements and invest-
ment reports.

Thomas also presented a 
review of membership dues for 
current General News Media, 
Affiliate News Media, Indi-
vidual, Retired and Strategic 
Partner members.

In committee reports, 
Education Committee Chair 
Dyer-Thompson asked Sutliff 
to provide an update on the 
June 7-8 convention. Sutliff 
said registration numbers were 
at about 90 percent of the prior 
year.

In the Government Rela-
tions update, Chair Wesner 
voiced appreciation for 
Thomas’ diligence in provid-
ing a government oversight to 
protect public notices and other 
newspaper interests in Oklaho-
ma. Thomas then reviewed a 
list of important bills from the 
2024 legislative session with 
the board.

In the report for the LSP 
committee, Thomas said the 
committee approved new LSP 
membership for Marietta Mon-
itor and Clinton Daily News. 

In other business, Thomas 

said the annual meeting of 
the Newspaper Association 
Managers (NAM) will meet 
in Oklahoma City on July 
30-Aug. 2, 2024. OPA will be 
the host association for the first 
time in the 100-year history 
of NAM. The board passed a 
motion to allow OPA/S staff 
to host a reception and tour of 
the OPA building for the NAM 
organization.

Thomas reviewed the busi-
ness meeting agenda and intro-
duced Dee Ann Patterson from 
The Lawton Constitution and 
Brian Blansett of The Lincoln 
County News as the nominees 
for director and treasurer. 

Thomas and the board 
thanked outgoing president 
Sheila Gay, outgoing treasurer 
David Stringer and outgoing 
past president Zonelle Rainbolt 
for their service on the board. 
Gay thanked board members 
for their work the past year.

OPS BOARD MEETING
The board reviewed the 

minutes of the April 11, 2024, 
meeting and approved them as 
presented.

OPS financial statements 
for the period ending April 
30, 2024, were reviewed and 
acknowledged as presented.

Capital expenditure requests 
included the purchase of two 
staff computers, which was 
approved by the executive 
committee of Gay, Belyeu and 

Stringer. The board approved 
the purchase of two additional 
staff computers in the 2024-
2025 fiscal year, if needed.

Thomas said two addition-
al capital expenditures will 
likely be needed soon, but cost 
estimates are not yet available. 
Several pipes connected to the 
building’s boiler need to be 
replaced this fall. The office 
phone system was purchased 
20 years ago and is no longer 
serviced due to its age. A new 
phone system or other arrange-
ments may soon be needed.

After the management 
review, Gay said the board was 
pleased with this year’s prog-
ress, including financial suc-
cess and the leadership shown 
in several areas. The board also 
expressed appreciation for the 
great work done by Lisa Sutliff 
and staff on the convention and 
many other successful projects 
throughout the year.

 

OPA Board of Directors meets in Oklahoma City

Got News?
Share news about your newspaper 
with other OPA members! If you 
have a new hire, sales promotion, 
contest, or have received an award 
or honor tell us about it so we can 
put it in The Oklahoma Publisher.

Send your news or story ideas to

aanderson@okpress.com  
or call 405-499-0020
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Enter and Win a  
$100 Check 

from Oklahoma 
Natural Gas!

The April and May 
Oklahoma Natural Gas  
Column and Editorial 

Contests were judged by 
members of the  

Oklahoma Journalism  
Hall of Fame.

1.	 Each month, submit your entry 
online at okpress.com/ong-
contest. Attachments should 
be in PDF format.

2.	 Entries may also be emailed 
(full-page tearsheet) to 
amartin@okpress.com. Include 
the author’s name, name of 
publication, date of publication 
and category entered (column 
or editorial).

3.	 All entries for the previous 
month must be at the OPA 
office by the 15th of the 
current month. 

4.	 Only ONE editorial and/or 
ONE column per writer per 
month will be accepted.

5.	 Winners will receive a 
Certificate of Achievement, a 
$100 check and the column 
or editorial may be published 
in The Oklahoma Publisher. 
Annual Sweepstakes winners 
will receive a plaque, a $200 
check and may have the 
column or editorial published 
in The Publisher. 

Contest open to staff at OPA 
Legal Newspaper and General 

News Media members, as well as 
OPA Individual members.

The views expressed in winning 
columns and editorials are those 
of the writers and don’t necessarily 
reflect Oklahoma Natural Gas 
Company’s opinions.

OKLAHOMA NATURAL GAS CONTEST WINNERS
CONGRATULATIONS TO THE APRIL AND MAY WINNERS

April Column: SARA ACOSTA, Woodward News
April Editorial: JAMES BEATY, McAlester News-Capital
May Column: JULIE TALTON, Countywide & Sun
May Editorial: KIM POINDEXTER, Tahlequah Daily Press

Excerpts from April and May winning entries. Read entire columns and editorials at okpress.com/ong-contest

APRIL COLUMN WINNER 
SARA ACOSTA, WOODWARD NEWS
A moment of darkness sheds light
What is it about the heavens that makes man look up into 
the sky in wonder?
Last year after the partial eclipse, I began to search out 
avenues to see the total eclipse in April.
Originally I wanted to make a camping trip of it, but after 
researching campgrounds in Southeastern Oklahoma, and 
with my budget and the four day booking requirements – 
those realities made that option a fantasy for me.
Fast forward a few months, and I decided to at least ask 
off from work for the day of the eclipse, because you never 
know when a wild hair might take you.
Eventually my plans settled on driving to a friend’s house 
in Oklahoma City, waking up at 5 AM and driving on I-40 
until we hit the center of the path of the eclipse.
We finally arrive to the day of the eclipse – and here we 
are – loading our sandwiches and drinks in a cooler, ush-
ering my friend’s bleary eyed teenage son out the door 
and into the Jeep.
The drive starts out with normal early morning road trip 
quietness, as we wake up and become energized by deli-
cious gas station rollerfoods.

APRIL EDITORIAL WINNER 
JAMES BEATY, McALESTER NEWS-CAPITAL
McAlester Council shouldn’t 
repeal the will of voters
In less than a minute Tuesday night, four McAlester 
city councilors voted to repeal an eighth-cent sales tax 
approved six years ago by a vote of the people.
The four city councilors who voted in favor of the motion did 
more than simply repeal the one-eighth cent sales tax des-
ignated for expansion of the McAlester Cancer Treatment 
Center.
They also voted to repeal the will of the voters who passed 
the sales tax measure in the first place.
Imagine the outrage among voters if state legislators 
repealed a state question passed by a vote of the people.
That’s essentially what the four city councilors did who 
voted Tuesday night to repeal the one-eighth cent sales 
tax measure. It’s a reckless move that could impact the 
McAlester Cancer Center for years to come.
On Feb. 13, 2018, city voters approved the one-eighth cent 
sales tax to provide funding for the McAlester Regional 
Health Center Authority to construct a modern regional 
cancer center to provide expanded cancer care and ancil-
lary services for Southeastern Oklahoma.

MAY COLUMN WINNER 
JULIE TALTON, COUNTYWIDE & SUN
Connect the Musical Dots
“So sit back, relax, and strap on your seatbelt. You never 
been on a ride like this befo’. With a producer who can rap 
and control the maestro.” Dr. Dre may have rapped it, but 
I will be pulling this duty on our upcoming vacation!  We 
will be playing a musical road trip game to keep everyone 
engaged and pass the time on our trip to the west coast. 
Who better to start off our journey than the lyrical genius 
and west coast rapper, Dr. Dre? Well, not everyone will 
agree with me here… but everyone in my vehicle will, and 
that’s what matters.
We are a music family. Not a musical family (because 
that would imply that we have a talent for making music… 
which we wholeheartedly do not)! However, we have a 
great appreciation for the art. So much so, that we often 
challenge each other to “who sings it?” Both daughters 
and I have a collection of band shirts, most of which we 
have seen in concert, some we only wish we had. BUT, 
none of which we don’t know the songs credited to them.  
My daughters have joined in on my pet peeve of people 
wearing clothing that they don’t understand. We aren’t 
jerks about it; if we don’t know you, we aren’t going to ask 
you to name a song AC/DC sings... 

MAY EDITORIAL WINNER 
KIM POINDEXTER, TAHLEQUAH DAILY PRESS
Butker’s remarks show he is out of touch
By now, almost everyone has heard about Harrison Butker, 
the Kansas City Chiefs kicker who put his cleated foot in 
his mouth during a commencement speech at Benedictine 
College. He should learn from the outrage his choice of 
words generated.
Butker’s speech – which calls to mind the series “The 
Handmaid’s Tale” – may seem unusual coming from a man 
of 28. Younger men are assumed to be more enlightened 
than their older brethren. Butker is an exception, though, 
and evidently many young men agree with his thought pro-
cess, and a number of women are striving to impress those 
men by championing it.
Speaking to a graduating class, Butker may have had good 
intentions, but one doesn’t have to be a “snowflake” to find 
his words repugnant: “I want to speak directly to you briefly 
because I think it is you, the women, who have had the 
most diabolical lies told to you. How many of you are sitting 
here now... thinking about all the promotions and titles 
you’re going to get in your career? ... I would venture to 
guess that the majority of you are most excited about your 
marriage and the children you will bring into this world.”


